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Introduction to profiles

Interaction Host Recorder is primarily a tool for building and editing host profiles, the scripts that allow handlers to send and
receive data from a host session. This topic offers an overview of one profile building method, but once you are familiar with the
process you can perform these steps in a different order.

Before you begin

Before you can begin creating host profiles make sure you have login and password information that the handlers will need to
connect with the host.

1.

Configure the connection properties

Before you can start a host session you must configure connection properties such as host address, type, and several more.
The online help for the Connection dialog explains the options. Once properly configured, you can connect to the host and open
the first screen.

Define the screen

After connecting, you should define the current screen. You must name the current screen before you can create validation
rules, user defined fields, or transitions. Handlers cannot act upon screens that are not defined.

Create validation rules for the new screen

Validation rules are the distinguishing characteristics of a specific named screen. You can define a screen by its screen ID, the
appearance of certain text in a certain location, or several other characteristics. The online help for the Validation Rules list
explains the different kinds of validation rules.

Creating user defined fields

User defined fields are the areas on the screen where handlers can read and write information. There are eight types of user
defined fields that allow you to define a set of coordinates, or a position relative to some other element on the screen. The
online help for User Defined Fields explains your options. You can create user defined fields on any named screen.

Creating Transitions

After defining one or more screens and setting the validation rules for those screens, you will probably want to create
transitions between the screens. Transitions are the collection of instructions (transition commands) used to move from one
screen to another. Interaction Host Recorder has a recording feature that allows you to automatically record transitions, or you
can create and edit them manually.

Publishing Host Profiles

When your host profile contains the defined screens, user defined fields, and transitions that you need, you can publish the host
profile to the Host Server. The Host tools in handlers can then tell the Host server to run the profiles and perform one or more
transitions within the host profile.




Command Line Parameters

The following command line parameters can be used when starting Interaction Host Recorder:
/ s={servername}

/notifier={servername}

/server={servername}

CIC server for publishing scripts to (if other than default)

/userid={userid}

User ID for publishing (if other than default)
/password={password}

Password for above User ID

/nopublish

Disables script publishing operations (prevents application from locking up for about 2 minutes when publishing attempted
without access to a CIC server).

/trace={type}

Sets level of tracing added to the trace buffer and shown in the trace history dialog.
{type}:

none No tracing

error Trace only errors

warning Trace errors and warnings

status Default, trace errors, warnings and status information

note All of the above including additional verbose information about execution process.

Note: The parameter keywords are not case sensitive.




Connections

Connecting to a host

You should connect to a host before creating or editing a host profile. Once you have connected to the host, the screen appears as
a terminal emulation in which you can navigate and create the host profile.

If you are creating a new profile:

After starting Interaction Host Recorder, open a new profile by clicking the New button on the toolbar. The Connection Properties
dialog appears. It is in this dialog that you must configure the connection settings, including the host type, interface type, and host
address. The Connection Properties dialog help contains detailed information on configuring the connection. Your connection
settings will be saved when you save the profile.

After configuring the connection properties, click the Connect button to establish a connection with the host.

If you are editing an existing profile:

If you are editing an existing profile, connection properties already exist for that profile. You can change these connection settings
by choosing Connection Properties... from the Host Menu. The Connection Properties dialog appears. You should reconnect to the
host after changing the connection settings for those changes to take effect.

Once the connection settings are correct, click the Connect button to establish a connection with the host.

After you have connected to the host, you can set up validation rules, user defined fields, and transitions.

Connection Properties

Connection properties are the settings to open a connection to the host. In this dialog you'll configure the host type, address,
display options, and several other settings. You must configure the connection properties for each new Host Profile that you create.

Once you've configured the parameters in this notebook, you can open the terminal emulation by clicking the Connect button.

5l
How to access the Connection Properties dialog

General Page
Name

The name of the host.
Host Type

Sets the type of host you want to connect to. This release supports Mainframe and AS/400 hosts. The choice you make here
determines what configuration options are available on the Attributes page.

Interface

Shows or sets the host communications interface used to connect to the host. Use this drop-down list to determine which
interface is currently selected or select an interface to connect with the host. For both Mainframe and AS/400 host types, you can
select TN 5250 (Telnet) or MS SNA Server.

Display Mode

Shows or sets the width and height for the display of the terminal emulation. If you choose the wrong size, the terminal emulation
may appear disorganized. If you have problems with the terminal emulation display, try changing this value.

8



Timeout

Shows or selects the number of seconds to wait for a connection before stopping the connection process. The connection is not
retried after this time is exceeded.

Driver

Both Recorder and Server driver are unique for the Host Type/Interface pair. For example, the Recorder driver for Mainframe TN
3270 is I3WdExpMFDriver. If you accidentally delete these settings, see Default Connection Drivers for the default settings.

Caution: These drivers are predefined during Interaction Host Recorder installation, and you should not change the default
values unless instructed to do so by a PureConnect Customer Care agent.

As Default button

Saves the current settings as the default for the current Host Type/Interface pair. If you click this button, a warning dialog appears
for you to confirm the action.

Attributes Page

The fields available on the Attributes page will change depending upon which Host Type/Interface pair you chose on the General
page.
Click on one of the pairs below for more information on the configurable attributes for that pair:
e Mainframe TN3270
Mainframe MS SNA Server

AS/400 TN5250
AS/400 MS NSA Server

Host types




Connection Attributes for AS/400 TN5250

The following fields are available on the Attributes page if AS/400 TN5250 is the Host Type/Interface pair chosen on the
Connection Properties General Page.

"
_I How to access the Connection Properties dialog

Address

Numeric or textual IP host address. For example, you could type locis.loc.gov or 140.147.254.3.
Port

The port over which the connection will be made with the host. Use 23 with TN 5250.

Device

Displays the logical name used by the host to identify this session. In most cases you can leave this field blank. Use Device to
assign a device name that will be used instead of the default device name. In most cases, the device name defaults to the PC
System name followed by S1 (workstation) or P1 (printer). For example, when the PC System name is MSMITH, the default device
name is MSMITHS1.

SSL Enabled option *

Indicates whether SSL encryption is enabled.

Authentication *

Indicates whether SSL authentication is enabled.

Licensing Server *

Sets the licensing server name for the Secure Socket Layer (SSL).
Failover Address

Provides the network connection redundancy for a host connection. This optional address allows Host Server Tools to use an
alternate, backup address to the host server (mainframe) in the event that the primary host address is unreachable.

Failover Port

The port to use for a specified failover address.

* Interaction Host Recorder does not natively include SSL encryption and authentication support. In CIC 3.0, you could use
NetManage (now MicroFocus) OnWeb Web-to-Host to take advantage of these SSL options. MicroFocus no longer packages the
required DLLs for SSL encryption and authentication support in their product line. Therefore, Interaction Host Recorder no longer
supports these SSL options. CIC and PureConnect releases after CIC 4.0 do not include the Host Server license and do not support
the ability to use the SSL encryption and authentication. Genesys recommends that you convert to a SOAP or REST solution instead
of using Host Interface tools.
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Connection Attributes for AS/400 MS SNA Server

The following fields are available on the Attributes page if AS/400 MS SNA Server is the Host Type/Interface pair chosen on the
Connection Properties General Page.

"
_I How to access the Connection Properties dialog

Device

Displays the logical name used by the host to identify this session. In most cases you can leave this field blank. Use Device to
assign a device name that will be used instead of the default device name. In most cases, the device name defaults to the PC
System name followed by S1 (workstation) or P1 (printer). For example, when the PC System name is MSMITH, the default device
name is MSMITHS1.

Local LU

Your local machine name.

Partner LU

Typically a system assigned value.

Auto Signon option

Selecting this option causes an automatic login using User ID and User Password when the connection is made.
User ID

The user ID to use when logging in.

User Password

The password associated with the user ID above.

Caution: This password is not protected, allowing a user to view the password in the host profile (.hcs file). Use the security
features in your operating system to protect the host profile from unauthorized users.

11



Connection Attributes for Mainframe TN3270

The following fields are available on the Attributes page if Mainframe TN3270 is the Host Type/Interface pair chosen on the
Connection Properties General Page.

"
_I How to access the Connection Properties dialog

Address

Numeric or textual IP host address. For example, you could type "locis.loc.gov" or "140.147.254.3".
Port

The port over which the connection will be made with the host. 23 is the default for telnet.
Device

Displays the logical name used by the host to identify this session. In most cases you can leave this field blank. Use DeviceName
to assign a device name that will be used instead of the default device name. In most cases, the device name defaults to the PC
System name followed by S1 (workstation) or P1 (printer). For example, when the PC System name is MSMITH, the default device
name is MSMITHS1.

Terminal

In most cases you can leave this field blank.

Extended Attributes

Returns or sets a value that specifies whether the TN3270 server supports 3270 extended attributes (TN3270E).
SSL Enabled option *

Indicates whether SSL encryption is enabled.

Authentication *

Indicates whether SSL authentication is enabled.

Licensing Server *

Sets the licensing server name for the Secure Socket Layer (SSL).
Failover Address

Provides the network connection redundancy for a host connection. This optional address allows Host Server Tools to use an
alternate, backup address to the host server (mainframe) in the event that the primary host address is unreachable.

Failover Port

The port to use for a specified failover address.

* Interaction Host Recorder does not natively include SSL encryption and authentication support. In CIC 3.0, you could use
NetManage (now MicroFocus) OnWeb Web-to-Host to take advantage of these SSL options. MicroFocus no longer packages the
required DLLs for SSL encryption and authentication support in their product line. Therefore, Interaction Host Recorder no longer
supports these SSL options. CIC and PureConnect releases after CIC 4.0 do not include the Host Server license and do not support
the ability to use the SSL encryption and authentication. Genesys recommends that you convert to a SOAP or REST solution instead
of using Host Interface tools.
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Connection Attributes for Mainframe TN3270

The following fields are available on the Attributes page if Mainframe TN3270 is the Host Type/Interface pair chosen on the
Connection Properties General Page.

"
_I How to access the Connection Properties dialog

Address

Numeric or textual IP host address. For example, you could type "locis.loc.gov" or "140.147.254.3".
Port

The port over which the connection will be made with the host. 23 is the default for telnet.
Device

Displays the logical name used by the host to identify this session. In most cases you can leave this field blank. Use DeviceName
to assign a device name that will be used instead of the default device name. In most cases, the device name defaults to the PC
System name followed by S1 (workstation) or P1 (printer). For example, when the PC System name is MSMITH, the default device
name is MSMITHS1.

Terminal

In most cases you can leave this field blank.

Extended Attributes

Returns or sets a value that specifies whether the TN3270 server supports 3270 extended attributes (TN3270E).
SSL Enabled option *

Indicates whether SSL encryption is enabled.

Authentication *

Indicates whether SSL authentication is enabled.

Licensing Server *

Sets the licensing server name for the Secure Socket Layer (SSL).
Failover Address

Provides the network connection redundancy for a host connection. This optional address allows Host Server Tools to use an
alternate, backup address to the host server (mainframe) in the event that the primary host address is unreachable.

Failover Port

The port to use for a specified failover address.

* Interaction Host Recorder does not natively include SSL encryption and authentication support. In CIC 3.0, you could use
NetManage (now MicroFocus) OnWeb Web-to-Host to take advantage of these SSL options. MicroFocus no longer packages the
required DLLs for SSL encryption and authentication support in their product line. Therefore, Interaction Host Recorder no longer
supports these SSL options. CIC and PureConnect releases after CIC 4.0 do not include the Host Server license and do not support
the ability to use the SSL encryption and authentication. Genesys recommends that you convert to a SOAP or REST solution instead
of using Host Interface tools.
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Profiles

Introduction to profiles

Interaction Host Recorder is primarily a tool for building and editing host profiles, the scripts that allow handlers to send and
receive data from a host session. This topic offers an overview of one profile building method, but once you are familiar with the
process you can perform these steps in a different order.

Before you begin

Before you can begin creating host profiles make sure you have login and password information that the handlers will need to
connect with the host.

1.

Configure the connection properties

Before you can start a host session you must configure connection properties such as host address, type, and several more.
The online help for the Connection dialog explains the options. Once properly configured, you can connect to the host and open
the first screen.

Define the screen

After connecting, you should define the current screen. You must name the current screen before you can create validation
rules, user defined fields, or transitions. Handlers cannot act upon screens that are not defined.

Create validation rules for the new screen

Validation rules are the distinguishing characteristics of a specific named screen. You can define a screen by its screen ID, the
appearance of certain text in a certain location, or several other characteristics. The online help for the Validation Rules list
explains the different kinds of validation rules.

Creating user defined fields

User defined fields are the areas on the screen where handlers can read and write information. There are eight types of user
defined fields that allow you to define a set of coordinates, or a position relative to some other element on the screen. The
online help for User Defined Fields explains your options. You can create user defined fields on any named screen.

Creating Transitions

After defining one or more screens and setting the validation rules for those screens, you will probably want to create
transitions between the screens. Transitions are the collection of instructions (transition commands) used to move from one
screen to another. Interaction Host Recorder has a recording feature that allows you to automatically record transitions, or you
can create and edit them manually.

Publishing Host Profiles

When your host profile contains the defined screens, user defined fields, and transitions that you need, you can publish the host
profile to the Host Server. The Host tools in handlers can then tell the Host server to run the profiles and perform one or more
transitions within the host profile.

Host Profile Grammar (.hcs files)

This topic explains the host profile syntax. We do not recommend that you manually make changes to your host profiles; rather, you
should edit your profiles using Interaction Host Recorder. This syntax is provided as an aid for advanced authoring and debugging.

Host profiles contain three sections: connection settings, screen declarations, and transitions.

Connection Settings

These settings correspond to those set up in the Connection Properties dialog .
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Syntax Example

<connection> := CONNECTION [<name>] Connection LOCIS

{<connectitems>}*

<connectitems> :=

HOSTTYPE = (Mainframe | AS400) | HOSTTYPE = MAINFRAME

DRIVER = <string>, <string> | DRIVER = "I3WdExpMFDriver",
"I3WdExpMFDriver"

INTERFACE = (TN3270 | TN5250 | SNA3270 | SNA5250) | [INTERFACE = TN3270

ADDRESS = <string> | ADDRESS = "locis.loc.gov"
ADDRESS = "129.71.2.10"

PORT = <posnum> | PORT = 23

MODE = (24x80 | 32x80 | 43x80 | 27x132) | MODE = 24x80

EXTATTR = <boolflag> | EXTATTR = TRUE

TIMEOUT = <posnum> TIMEOUT = 30

DEVICE = <string> |

TERMINAL = <string> |

SSLENABLED = <boolflag> | SSLENABLED = FALSE

SSLAUTHENTICATION = <boolflag> | SSLAUTHENTICATION = FALSE

SSLLICENSINGSERVER = <string> |

LU = <string> |

LOCALLU = <string> |

PARTNERLU = <string> |

SYSTEMNAME = <string> |

DEVICENAME = <string> |

AUTOSIGNON = <boolflag> | AUTOSIGNON = TRUE

USERID = <String> USERID = "JohnD"

USERPASSWORD = <string> USERPASSWORD = "MyPassword"

Screen Declarations

Screen declarations are the screens you name in the Screen Definition window. Screen declarations contain validation rules and
user defined fields. The <boolflags> corespond to the option settings users encounter when editing via the Interaction Host
Recorder. You can view these options creating a similar field using the appropriate dialog in Interaction Host Recorder.

Screen Declaration

16



Syntax

Example

<screendecl> := SCREEN <name>

{(FIELD <name> = <field decl>}”

VALIDATION (<posnum>) = <validation> {, <validation>}";

SCREEN MainScreen

Validation Rules

Syntax

Example

<validation> :=

Wait (<posnum>) |

ID (<number>) |

Type (<number>) |

StringAt ( (<posnum> | *), (<posnum> |
<boolflag>) |

CursorAt ( (<posnum> | *), (<posnum> |

IsReadyToSend

-

<string>,

VALIDATION (5000) = StringAt (68, 24,
"LLOCISMENU ", FALSE),

StringAt (7, 23, "Choice: 2 ", FALSE),
ID(-185882193),

IsReadyToSend

Wait (100)

ID(-238147156)

Type (1)

StringAt (68, 24, "LOCISMENU ", FALSE)

CursorAt (6, 24)

IsReadyToSend

17




<string>, <boolflag>, <string>,
<boolflag>, <number>, <number>[,
<boolflag>[, <boolflag>]])

TRUE, "PF1",

FALSE, 0, -44, TRUE, TRUE)

Syntax Example

<field decl> :=

AbsPos ( (<posnum> | *), (<posnum> | *), FIELD Field0Ol = AbsPos (1, 1, 80, FALSE, TRUE)
<length>[, <boolflag>[,

<boolflag>]]) |

RelPos (<number>, <number>, <length>[, FIELD Field02 = RelPos (52, 1, 12, FALSE, FALSE)
<boolflag>[, <boolflag>]]) |

OrdP (<posnum>[, <boolflag>[, FIELD FieldO3 = OrdP(l1, FALSE, FALSE)

<boolflag>]1]) |

OrdU (<posnum>[, <boolflag>[, FIELD Field0O4 = OrdU(l1, FALSE, FALSE)

<boolflag>]]) |

RelStringTopDown (<posnum>, <string>, FIELD FieldO5 = RelStringTopDown (3, "Usc", -6, 15, 3,
<number>, <number>, <posnum>, FALSE, TRUE, TRUE)

<boolflag>[, <boolflag>[, <boolflag>]]) |

RelStringBottomUp (<posnum>, <string>, FIELD Field0O6 = RelStringBottomUp (3, "USC", -6, 18, 3,
<number>, <number>, <posnum>, FALSE, TRUE, TRUE)

<boolflag>[, <boolflag>[, <boolflag>]]) |

StringDelimitedTopDown (<posnum>, FIELD FieldO7 = StringDelimitedTopDown(l, "===> ",
<string>, <boolflag>, <string>, TRUE, "PF1", FALSE, 0, -44, TRUE, TRUE)

<boolflag>, <number>, <number>[,

<boolflag>[,

<boolflag>]])

StringDelimitedBottomUp (<posnum>, FIELD FieldO07 = StringDelimitedBottomUp (1, "===> ",

<transdecl> :=TRANSITION (STARTUP |

* .
COMMANDS = <transcmd> {, <transcmd>} '

Syntax | Example

<name>) =><name>

18




<transcmd> := TRANSITION STARTUP -> MainScreen

TRANSITION CopyrightDocumentFile ->

MainScreen
Validate (<name>) | Validate (MainScreen)
PutString ((<posnum> | *), (<posnum> | *), <string>) | PutString (24, *, "hello")
PressKey (<string>) | PressKey ("1")

PressKey ("@E")

WaitForRTS (<posnum>) | WaitForRTS (5000)

Wait (<posnum>) | Wait (300)

WaitForString ( (<posnum> | *), (<posnum> | *), <string>, WaitForString (6, 24, "Tolkien", FALSE,

<boolflag>, 2000)

<posnum>) |

WaitForCursor ( (<posnum> | *), (<posnum> | *), <posnum>) | [WaitForCursor (22, 24, 4500)
WaitForScreenlID (<number>, <posnum>) | WaitForScreenID(-238147156, 2000)
WaitForScreenType (<number>, <posnum>) | WaitForScreenType (1, 2000)
SetCursor ( (<posnum> | *), (<posnum> | ¥*) SetCursor (6, 24)

<name> := (a-z|A-Z| ) {(a-z|A-Z|0-9] )}*

<posnum> := {0-9}+

<number> := [(+|-)] {0-9}+

<string> := " {(<any char> | <escapeseqg>)}* "

<boolflag> := (TRUE | FALSE)

<netname> := {(a-z|A-Z]0-9| [-)}~*

<escapeseqg> := \" [ \" | \\ [ \?2 | \a | \b | \f | \n | \r |

\t | \v | \x<hexdigit><hexdigit>

<hexdigit> := (0-9]a-f|A-F)

# Starts a line of comments (rest of the line ignored)

Sample Profile (.hcs file)

This topic contains the text found in a fully functional host profile. While we do not recommend that you create or edit host profiles
manually, this profile serves as an sample of the types of commands you will find in a host profile. See Host Profile Grammar (.hcs
files) for more information on the individual commands found in a host profile.

SR

####4# IC Host Connectivity Script --- Do Not Modify! #####

CONNECTION LibOfCongress

HOSTTYPE = Mainframe

19



DRIVER = "I3WdExpMFDriver",
INTERFACE = TN3270
ADDRESS = "locis.loc.gov"
PORT = 23

MODE = 24x80
EXTATTR = TRUE

TIMEOUT = 30

SCREEN CommentsAndLogoff
VALIDATION (5000) =
StringAt (68, 24,

IsReadyToSend;

SCREEN CopyrightDocumentFile

VALIDATION (5000) =

StringAt(l, 2, "***COHD- THE COPYRIGHT DOCUMENTS FILE", FALSE);

SCREEN CopyrightInfo

VALIDATION (5000) = StringAt (68, 24, "COPYRIGHT ", FALSE),

ID(-112686159);

SCREEN LocisCatalog

VALIDATION (3000) = StringAt (68, 24, "LC CATALOG", FALSE),

StringAt (*, *, "Choice", TRUE);

SCREEN MainScreen

VALIDATION (3000) = StringAt (68, 24, "LOCISMENU ", FALSE),

StringAt(*, *, "Choice", TRUE),

StringAt (7, 23, "Choice: ", FALSE),

CursorAt (16, 23),

IsReadyToSend;

FIELD Fieldl = RelPos (52, 1, 12, FALSE, FALSE)

FIELD Field2 = RelStringBottomUp(l, "Choice:", 9, 0, 2, TRUE, FALSE, FALSE)
FIELD Field3 = StringDelimitedTopDown(l, "12", FALSE,"ch", TRUE, 0, 0, TRUE, TRUE)
FIELD Field4 = StringDelimitedTopDown (3, "Library", FALSE,"LOCIS", FALSE, 0, 0, FALSE,
FIELD LineOl = AbsPos(l, 1, 80, FALSE, TRUE)

FIELD LineO2 = AbsPos(l, 2, 80, FALSE, TRUE)

FIELD Line0O3 = AbsPos(l, 3, 80, FALSE, TRUE)

FIELD LineO4 = AbsPos(l, 4, 80, FALSE, TRUE)

FIELD LineO5 = AbsPos(l, 5, 80, FALSE, TRUE)

FIELD LineO6 = AbsPos(l, 6, 80, FALSE, TRUE)

FIELD LineO7 = AbsPos(l, 7, 80, FALSE, TRUE)

FIELD Line08 = AbsPos(l, 8, 80, FALSE, TRUE)

FIELD Line09 = AbsPos(l, 9, 80, FALSE, TRUE)

FIELD LinelO = AbsPos(l, 10, 80, FALSE, TRUE)

"COMMENTS/OFF ",

"I3WdExpMFDriver"

ID(-679864668),

FALSE),

ID(7355349),

FALSE)
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FIELD Linell = AbsPos(l, 11, 80, FALSE, TRUE)
FIELD Linel2 = AbsPos(l, 12, 80, FALSE, TRUE)
FIELD Linel3 = AbsPos(l, 13, 80, FALSE, TRUE)
FIELD Linel4 = AbsPos (1, 14, 80, FALSE, TRUE)
FIELD Linel5 = AbsPos (1, 15, 80, FALSE, TRUE)
FIELD Linel6 = AbsPos(l, 16, 80, FALSE, TRUE)
FIELD Linel7 = AbsPos(l1, 17, 80, FALSE, TRUE)
FIELD Linel8 = AbsPos(l, 18, 80, FALSE, TRUE)
FIELD Linel9 = AbsPos (1, 19, 80, FALSE, TRUE)
FIELD Line20 = AbsPos (1, 20, 80, FALSE, TRUE)
FIELD Line2l = AbsPos(l, 21, 80, FALSE, TRUE)
FIELD Line22 = AbsPos(l, 22, 80, FALSE, TRUE)
FIELD Line23 = AbsPos(l, 23, 80, FALSE, TRUE)

FIELD Line24 = AbsPos (1, 24, 80, FALSE, TRUE)

SCREEN MainScreenSell
VALIDATION (5000) = StringAt(*, *, "Choice:", FALSE),
StringAt (68, 24, "LOCISMENU ", FALSE),

StringAt (7, 23, "Choice: 1 ", FALSE);

SCREEN NoLUsAvailable

VALIDATION (3000) = StringAt(l, 4, " No LUs available now, please try later", FALSE),
ID(298566241) ;

FIELD UserID = OrdU(l, FALSE, FALSE)

FIELD Password = OrdU (2, FALSE, FALSE)

FIELD NewPassword = OrdU (3, FALSE, FALSE)

FIELD Application = 0OrdU(4, FALSE, FALSE)

SCREEN Screenl

VALIDATION (5000) = StringAt (68, 24, "LOCISMENU ", FALSE),
StringAt (7, 23, "Choice: 2 ", FALSE),

ID(-185882193),

IsReadyToSend;

SCREEN ScreenlO
VALIDATION (5000) = CursorAt (17, 23),

StringAt (16, 23, " ", FALSE);

SCREEN Screen?2
VALIDATION (5000) = ID(0),

Type (1) ;

SCREEN Screen3

VALIDATION (5000) = StringAt (7, 23, "Choice: 12", FALSE);

SCREEN Screen4
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VALIDATION (5000) = StringAt(7, 23, "Choice: 12", FALSE);

SCREEN Screenb5

VALIDATION (5000) = CursorAt (32, 9);

SCREEN Screen6

VALIDATION (5000) = CursorAt (52, 13);

SCREEN Screen”

VALIDATION (5000) = CursorAt (52, 13);

SCREEN Screen8

VALIDATION (5000) = CursorAt (58, 17);

SCREEN Screen9

VALIDATION (5000) = StringAt(7, 19, "The Organizations (NRCM) file is no longer created or
supported by LC. It has been removed from LOCIS.", FALSE),

StringAt (7, 23, "Choice: 3 ", FALSE);

SCREEN SearchItemAfter1975
VALIDATION (3000) = StringAt(l, 2, "***LOC3- THE LIBRARY OF CONGRESS INFORMATION SYSTEM", FALSE);

FIELD Fieldl = AbsPos (27, 23, 116, FALSE, FALSE)

SCREEN SearchItemsl1950to0l1974
VALIDATION (5000) = StringAt(l6, 6, "LOC2 lists books cataloged 1950-74.", FALSE);

SCREEN SearchResultPgl
VALIDATION (3000) = StringAt (70, 1, " (BKS3)", FALSE);

FIELD Subjects = StringDelimitedTopDown (1, "SUBJECTS:", FALSE,"OTHER NAMES:", FALSE, 71, O,
FALSE, TRUE)

FIELD CallNumber = RelStringTopDown(l, "LC CALL NUMBER:", 16, 0, 64, FALSE, FALSE, TRUE)

FIELD LibEntry = StringDelimitedTopDown (1, " (BKS3)", FALSE,"LC CALL NUMBER", FALSE, 85, 0, FALSE,
TRUE)

TRANSITION STARTUP -> MainScreen
COMMANDS = WaitForRTS (5000),
WaitForRTS (2000),

Validate (MainScreen) ;

TRANSITION CopyrightDocumentFile -> MainScreen
COMMANDS = Validate (CopyrightDocumentFile),
PressKey ("exit"),

PressKey ("@E"),

WaitForCursor(l, 1, 5000),

WaitForCursor (16, 23, 5000),

WaitForRTS (5000),

Validate (MainScreen) ;
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TRANSITION CopyrightInfo -> CopyrightDocumentFile
COMMANDS = Validate (CopyrightInfo),

PressKey ("3"),

PressKey ("@E"),

WaitForCursor (1, 1, 5000),

WaitForCursor (27, 12, 5000),

WaitForRTS (5000),

Validate (CopyrightDocumentFile) ;

TRANSITION CopyrightInfo -> MainScreen
COMMANDS = Validate (CopyrightInfo),
PressKey ("12"),

PressKey ("@E"),

WaitForCursor (1, 1, 5000),
WaitForCursor(le6, 23, 5000),
WaitForRTS (5000),

Validate (MainScreen) ;

TRANSITION LocisCatalog -> SearchItemAfterl1975
COMMANDS = Validate (LocisCatalog),

PressKey ("3@E"),

WaitForRTS (5000),

Validate (SearchItemAfter1975);

TRANSITION LocisCatalog -> MainScreen
COMMANDS = Validate (LocisCatalog),
PressKey ("12"),

PressKey ("@E"),

WaitForCursor(l, 1, 5000),
WaitForCursor (16, 23, 5000),
WaitForRTS (5000),

Validate (MainScreen) ;

TRANSITION LocisCatalog —-> MainScreen
COMMANDS = Validate (LocisCatalog),
PressKey ("12"),

PressKey ("@E"),

WaitForCursor(le6, 23, 1100),
WaitForRTS (1100),

Validate (MainScreen) ;

TRANSITION MainScreen -> LocisCatalog
COMMANDS = Validate (MainScreen),

PressKey ("@T1@E"),
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WaitForRTS (5000),

Validate (LocisCatalog) ;

TRANSITION MainScreen -> CopyrightInfo
COMMANDS = Validate (MainScreen),
PressKey ("3"),

PressKey ("@QE"),

WaitForCursor (1, 1, 5000),
WaitForCursor(le, 23, 5000),
WaitForRTS (5000),

Validate (CopyrightInfo) ;

TRANSITION MainScreen -> SearchItemAfterl1975
COMMANDS = Validate (MainScreen),
PressKey ("1"),

PressKey ("@E"),

WaitForCursor (1, 1, 5000),
WaitForCursor (17, 24, 5000),
WaitForRTS (5000),

PressKey ("3"),

PressKey ("@E"),

WaitForCursor(l, 1, 5000),
WaitForCursor (27, 23, 5000),
WaitForRTS (5000),

Validate (SearchItemAfter1975);

TRANSITION MainScreen -> MainScreen
COMMANDS = Validate (MainScreen),
PressKey ("1"),

PressKey ("@E"),
WaitForCursor (17, 24, 5000),
WaitForRTS (5000),

Validate (LocisCatalog),

PressKey ("3"),

PressKey ("@E"),
WaitForCursor (27, 23, 5000),
WaitForRTS (5000),

Validate (SearchItemAfter1975),
PressKey ("booch"),

PressKey ("@E"),
WaitForCursor (11, 23, 5000),
WaitForRTS (5000),

PressKey ("b6"),

PressKey ("@E"),

WaitForCursor (8, 19, 5000),
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WaitForRTS (5000),

PressKey ("exit"),

PressKey ("@E"),
WaitForCursor(l6, 23, 5000),
WaitForRTS (5000),

Validate (MainScreen) ;

TRANSITION MainScreen -> LocisCatalog
COMMANDS = Validate (MainScreen),
PressKey ("1"),

PressKey ("@E"),

Validate (LocisCatalog) ;

TRANSITION MainScreen -> ScreenlO
COMMANDS = Validate (MainScreen),
PressKey ("1"),

PressKey ("@E"),
WaitForCursor (17, 24, 1000),
WaitForRTS (1000),

PressKey ("3"),

PressKey ("@E"),
WaitForCursor (27, 23, 1100),
WaitForRTS (1100),

PressKey ("radio"),

PressKey ("@E"),
WaitForCursor (8, 18, 3600),
WaitForRTS (3700),

PressKey ("2"),

PressKey ("@E"),
WaitForCursor (8, 20, 1000),
WaitForRTS (1000),

PressKey ("display item 2"),
PressKey ("@E"),
WaitForCursor (65, 21, 1200),
WaitForRTS (1200),

PressKey ("simsp"),

PressKey ("@<"),

PressKey ("@<"),

PressKey ("@<"),

PressKey ("@<"),

PressKey ("@<"),

PressKey ("newtons"),
PressKey ("@<"),

PressKey ("@E"),

WaitForCursor (8, 20, 1600),
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WaitForRTS (1600),

PressKey ("1"),

PressKey ("@E"),
WaitForCursor (8, 20, 1000),
WaitForRTS (1000),

PressKey ("exit"),

PressKey ("@E"),
WaitForCursor(le, 23, 1400),
WaitForRTS (1400),

Validate (ScreenlO) ;

TRANSITION Screen9 -> LocisCatalog
COMMANDS = Validate (Screen?9),
PressKey ("@T"),

PressKey("1"),

PressKey ("@E"),

WaitForCursor (17, 24, 1000),
WaitForRTS (1000),

Validate (LocisCatalog) ;

TRANSITION SearchItemAfter1975 -> MainScreen
COMMANDS = Validate (SearchItemAfterl1975),
PressKey ("@T"),

PressKey ("exit"),

PressKey ("@E"),

WaitForCursor(l, 1, 5000),

WaitForCursor (16, 23, 5000),

WaitForRTS (5000),

Validate (MainScreen) ;

# End of file #
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Screens

Defining Screens

Before you can create validation rules or user defined fields on a screen, you must define that screen. While you can define a screen
simply by giving it a name, Interaction Host Recorder cannot accurately identify that screen until you create validation rules for that
screen.

To Define a New Screen

After connecting to the host, navigate to the screen you want to define. Once that screen is loaded, right-click in the Screen list and
choose Add Screen... from the menu that appears. The Screen Properties dialog appears in which you can name the screen and
define its validation rules . After you click OK, the screen name appears in the Screen list. Any time that screen is loaded and the
validation rules match, that screen name appears in the Screen list.

After a screen is named, you can edit the screen name and validation rules by right-clicking the screen name and choosing the
appropriate command from the menu that appears.

Screen Properties dialog

The Screen Properties dialog is where you name and define validation rules for a screen. This screen appears any time you choose
to add a screen manually, or if you stop at an unrecognized screen when you are recording transitions automatically.

Validation Page

On this page you can view or create validation rules.

Timeout

The amount of time to wait for this screen to load before checking the validation rules.
Commands

The validation rules defined for this screen.

Fields Page

On this page you can view or create user defined fields.
Fields

The amount of time to wait for this screen to load before checking the validation rules.
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Validation Rules

Validation Rules

Validation rules contain information for identifying the currently active screen. When a screen appears, Interaction Host Recorder
checks the validation rules to determine which screen is loaded. If a person were sitting at the terminal emulation, that person
could tell that a screen was valid just by waiting until it finished loading and reading it. When a handler is running the terminal
emulation, things become more complicated. The validation rules must specify exactly what determines a valid screen. In many
cases you will want to use more than one validation rule, just to make sure that the screen is correct.

When Host Server runs your profile, it will only validate the screen when instructed to do so in a transition command. This means
that you will need to configure when screens are validated in your transition commands. If you are recording transition commands
automatically, then the validations are inserted for you, but you can also add or remove validations manually in the Transitions
Commands window.

Create and edit validation rules in the Screen Definition window

Note: For a new screen (previously undefined in this host profile), you must first name that screen before you can create validation
rules.

Interaction Host Recorder evaluates each rule in your list, starting with the top rule in the list. Once it has determined that the first
rule is valid, it goes on to the next rule in the list. Interaction Host Recorder will continue to evaluate a rule until it succeeds or
times out. (You can set the time out value by right-clicking in the Screen Definition window and choosing Screen Properties from
the dialog that appears.

There are six types of validation rules:

e ScreenID
Each screen has a unique identifier generated mathematically from the number, position, and length of the fields. If you know
that the fields will always be in the same place and of the same length, you can use this value. You can use screen ID even if
some of the values within fields are going to change. For example, if there is a time stamp located in the top left corner, and
that field is always the same length, the screen will keep it's unique id even if the time of day is different.

e Screen Type
The number of unprotected fields on the screen. If you know that a screen has finished loading when an input field has
appeared, use the screen type as one of your validation rules. It is possible that several different screens will have the same
number of input fields, and thus have the same screen type. In most cases, screen type should not be used as the only
validation rule. This validation rule should only be used when a screen will always have the same number of unprotect6ed
fields.

e Match Text
This versatile validation rule allows you to look for a specific text string anywhere on the screen, anywhere starting at a specific
row, anywhere starting in a specific column, or starting in a specific row/column coordinate. You should use this validation rule
when you know that each screen has a unique identifier somewhere on the screen. Many mainframe application designers
realize that their screens will be evaluated electronically, so they include a unique number in a corner of the screen.

e Wait
Forces a pause while Interaction Host Recorder validates the screen. Wait should only be used when no other validation rules
can be used to validate the screen.

Caution: Be careful that you don't set the wait time for longer than the validation timeout or the validation will always fail.

e Cursor Position
Looks for the cursor in a specific row, column, or row/column coordinate. For example, you might use cursor position when
you know that the cursor will be in row twenty-five when the screen has finished loading. You should not use cursor position if
the cursor is not always in the same location after a screen loads.

e Is Ready to Send (RTS)
Checks to see if the host has sent an RTS signal indicating that the screen is ready to accept user input. You might use this as
a final validation rule after other rules have been checked. For example, if the host sends between fifteen and twenty RTS
signals before the screen finishes loading, then you might Match Text for a textual value at the bottom of the screen and then
validate the RTS signal. This way you know that the screen has finished loading and is ready for input.
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Creating Validation Rules

Validation rules contain information for identifying the currently loaded screen. When a screen appears, Interaction Host Recorder
checks the validation rules to determine which screen is loaded. While you can configure Interaction Host Recorder to validate a
screen every time you make a change on that screen (see Preferences), the handlers will only validate a screen when instructed to
do so by a transition command.

Before you can create a validation rule, you must connect to a host and define the screen for which you will create validation rules.
Once you have defined the screen, make sure that screen is loaded and selected in the Screen Definition window create a validation
rule by right-clicking in the Validation Rules list and choose Add Validation... from the menu that appears. The Validation dialog
appears in which you can configure the validation rule type and settings. See Validation Rules for more information on the types of
validation rules.

Once you click OK, the validation rule appears in the Validation Rules list. You can edit the properties of this validation rule at any
time by right-clicking the validation rule and choosing Edit Validation... from the menu that appears.
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User Defined Fields

User Defined Fields

User defined fields are areas you define in a screen to allow handlers to write information to and from that screen. In short, they
allow handlers to interact with the screens. The Host tools in handlers can bind variables in the handlers to user defined fields in
the host profile. This allows handlers to write information to and from the screen.

User defined fields are listed in the Screen Definition window.

Note: You must create user defined fields, as opposed to screen fields that Interaction Host Recorder creates automatically when a
screen is opened. Create, edit, and delete user defined fields by right-clicking in the User Defined Fields area and choosing the
appropriate command from the menu that appears.

The following list contains links to detailed descriptions of the types of user defined fields that you can create:

o Absolute Position
Absolute position defines a field at a specific set of coordinates. Typically these are useful when you can accurately predict the
contents of a screen, such as a menu screen.

o Relative Position
Relative position uses the current cursor position as a starting point. While you can perform the same operation with Absolute
coordinates, Relative Position allows you to offset the field from the cursor. This is useful if you cannot predict the contents of
the screen, but you know that the cursor is always at the input field when the screen has loaded.

e Ordinal
Ordinal protected and unprotected target a specific field in a series of fields. For example, if you know that a screen always has
three unprotected fields, you could specify the first, second, or third unprotected field as a user defined field.

e Anchor String
Anchor strings allow you to define a field based on the location of a certain word or character in the screen.

e String Delimited
String delimited user defined fields are bounded by two strings that you specify. This method is useful when you don't know
how long the string will be, but you can define a textual start and end point.

Creating and Editing User Defined Fields

User defined fields are areas you define in a screen to allow handlers to write information to and from that screen. In short, they
allow handlers to interact with the screens. The Host tools in handlers can bind variables in the handlers to user defined fields in
the host profile. This allows handlers to write information to and from the screen.

Creating User Defined Fields

After you have defined a screen, you can create user defined fields within that screen. (We recommend that you create validation
rules when you define a screen.)

Use your mouse pointer to select an area on the screen, then right-click in the selected area and choose Add User Defined Field...
from the menu that appears. The User Defined Field dialog appears. Name your field and select the type of field you wish to add. For
an explanation of the types of fields you can define, see the online help in the User Defined Field dialog. When you click the OK
button, the new user defined field appears in the User Defined Fields list.

Editing User Defined Fields

You can edit the properties of a user defined field by right-clicking that field in the User Defined Field list and choosing Edit Field...
from the menu that appears. The User Defined Field dialog opens where you can make your changes.

Types of User Defined Fields

Absolute Position User Defined Fields

Using absolute position is really just assigning the screen coordinates where the field will be located. Absolute coordinates allow
you to define a specific column location and row location on a screen. You can also define row or column (or both) at the current
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cursor position. Using cursor position introduces flexibility because handlers can move the cursor on the screen, moving the field
with the cursor. This topic describes the four ways in which you can use absolute position to define a field.

o Specify row and column coordinates to define an exact position on the screen. Use this method if you are sure that the value
must be retrieved from a precise row and column coordinate every time.

Example: Absolute field at Row=23, Col=9, length=2

Acme Explosives Corporation Depicreen 2-8413
Account Check # Deposits
12564 1881 e
12564 1882 188
12564 1883 158
12564 1084 75
12564 1885 L5
12564 1886 25
12564 1887 188
Press M for menu
Press X to Exit
Choice: [ |

o Specify only a column position if you know that the field will always be in a specific column. No matter which row the cursor is
in, the field will be in the specified column on the cursor row. The Host Move to Position tool in a handler can move the cursor
down the column.

This method is useful with tabular data is in a vertical column, and you want to retrieve data down that column.

Example: Absolute field at Row=Cursor, Col=31, length=9

31



Acme Explosives Eurpa.etiun DepScreen 2-8413

Cursor

Account Position Likd Deposits

12564 1891

12564 Cursor 100

, Position

12564 150

12564 Cursor
Position

12564 10885 45

12564 1006 25 1] —

12564 1087 168

Press M for menu
Press ¥ to Exit
Choice:

v

e Specify only a row position if you know the field will be in specific row. No matter which column the cursor is in, the field will be
in the specified row. This method is useful with tabular data is in a horizontal row, and you want to retrieve data across that
row. The Host Move to Position tool in a handler can move the cursor across the row.

Example: Absolute field at Row=12, Col=Cursor, length=7
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Acme Explosives Corporation Depicreen 2-8413

Account

188

Position 158

75

Cursor

Press M for menu =
Press X to Exit Position

Choice:

e Set Row and Column to Cursor Position if you know that the cursor always ends up at a specific location. Using this method,
the field starts at the current cursor position, wherever that is on the screen. If you want the field to start before or after the
current cursor position, use relative position because it allows offsetting.

Example: Absolute field at Row=Cursor, Col=Cursor, length=7
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Acme Explosives Corporation Depicreen 2-8413

Check # Deposits
Cursor et
Position

5@
100
12564 1003 158

12564

12564 Cursor

Position

12564

12564

Press M for menu
Press ¥ to Exit
Choice:
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Anchor String User Defined Fields

Anchor strings allow you to define a field based on the location of a certain word or character in the screen. For example, if you
know that the word "Choice:" appears on a screen, you can define a field based on the location of Choice.

When defining anchor strings, you can specify anchor string from top, or anchor string from bottom. Choose top if you want to start
searching for occurrences from the top of the string; choose bottom if you want to start searching for occurrences from the bottom
of the screen.

Use anchor string when you can't predict the contents of a screen, such as tabular data of undetermined length, or when you can't
predict the number of protected or unprotected screen fields. In short, anchor string provides an alternative method when other
methods are not reliable.

Example: Occurance = 1, Text = Choice:, Row offset = 0, Column offset = 9

Acme Explosives Corporation DepScreen 2-8413
Aiccount Check # Deposits
12564 1881 e
12564 1882 188
12564 1883 158
12564 1084 75
12564 1885 L5
12564 1886 25
12564 1887 188
Press M for menu
Press ¥ to Exit
Choice:
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Ordinal User Defined Fields

Ordinal definitions allow you to define a specific field in a series of fields. When mainframe programmers design screens, they may
specify the number of protected or unprotected fields in that screen. For example, a menu may contain 10 protected fields and 1
unprotected field. You can use this to your advantage by creating a user defined field at the first unprotected field. In this example,
your user defined field would always be at the correct location for specifying the menu entry.

You should use ordinal field definitions if the number of fields (either protected or unprotected) on a screen is constant.
See Screen Fields for more information on protected and unprotected screen fields.

Example: Ordinal Unprotected Ordinality 1

Acme Explosives Corporation DepScreen 2-8413
Aiccount Check # Deposits
12564 1881 e
12564 1882 188
12564 1883 158
12564 1084 75
12564 1885 L5
12564 1886 25
12564 1887 188
Press M for menu
Press ¥ to Exit
Choice:
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Relative Position User Defined Fields

Relative position uses the current cursor position as a reference point. While you can perform the same operation with absolute
position, relative position allows you to offset the field from the cursor. You can offset by rows and columns, and by positive or
negative values. This allows you to specify a field above, below, before, or behind the current cursor position.

Use relative position if you can reliably predict the cursor location. One use for this method is for menu entries, such as when the
cursor is located in the choice field.

Example: Row offset = 0, Column offset = -7, Length = 2

Acme Explosives Corporation DepScreen 2-8413
Aiccount Check # Deposits
12564 1881 e
12564 10882 1048
12564 10883 1548
12564 14084 75
12564 108485 L5
12564 108864 25
12564 1887 1448
Cursor
Position
Fress M for menu
Press ¥ to Exit
Choice: [ _
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String Delimited User Defined Fields

String delimited user defined fields are bounded by two strings that you specify. This method is useful when you don't know how
long the string will be, but you can define a start and end point. In the following example, a field is defined between the word "Title:"
and the word "Call Number". As you can see in the example, this field could change length depending upon the number of characters
in the field.

Example: Left Delimiter = Title, Right Delimiter = Call Number:, Occurrence = 1, Left Field Offset = 71.

T 36363636 363636 36 36 3E 363636 X R XX ¥ N ®EE¥X Public Lj_hrary 36 3636 36 36 3 3636 36 36 36 36 36 36 36 36 36 36 36 363 36 36 36 36 36 36 36 3636

Title:
Tolkien, J. R. R. {John Ronald Reuel), 1892-1973.

The hobbit, or, There and back again / by J.R.R. Tolkien ; illustrated by
[plan Lee. Boston : Houghton Hifflin Co., c1997. 288 p. : ill. (some col.) ;
26 cm.

CALL HUMBER: PZ27.T574Y4 Ho 1907

SUBJECTS:
Middle Earth {Imaginary place)--Fiction.
Fantasy.

OTHER HAHES:
Lee, Alan, ill.

OTHER TITLES:
Hobbit
There and back again

HOTES:
PAGE 1 OF 2. READY FOR HEW COMHAHD OR PAGE #(FOR HXT PG, XMIT):
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Transitions

Transition Commands

Transition commands are the actions taken to move from one screen to another. Transitions are made up of one or more transition
commands. Transition commands are listed in the Transition Commands window, and they are executed in the order they are listed.

To edit a transition command, right-click on the transition command and choose Edit... from the menu that appears.

Note: Some transition commands are not recorded automatically, and you must insert them manually after you record a transition.
Transition commands colored red in the list below are recorded automatically. To manually insert a transition command, right-click
in the transition command list and choose Insert Command... from the menu that appears. You can then move the transition
command up and down in the list by right-clicking the transition command and choosing Move Up or Move Down from the menu
that appears.

There are ten types of transition commands:
o Validate

Validates the current screen using the validation rules prescribed for that screen.
o Press Key

Sends one or more keys to the screen. You can remap your keyboard and map multiple keys to a single key press in the
Preferences dialog.
e Wait for RTS

Instructs the transition to wait for a ready to send signal before executing the next transition command. Use this transition
command carefully because you may not be able to predict the number of ready to send signals that the host will send while
loading a screen. As a result, the screen may not fully loaded before the next transition command is executed.

o Wait for String

Instructs the transition to wait for the appearance of a specific string on the host screen. You can configure which string to
watch for, where the screen should appear, and several other properties. This transition command must be inserted manually.
o Wait for Cursor

Instructs the transition to wait for the appearance of the cursor on the screen. You can optionally specify a cursor location, and
the amount of time to wait before timing out.

e Wait for Screen ID

Instructs the transition to wait for a specific screen ID. This transition command must be inserted manually.
o Wait for ScreenType

Instructs the transition to wait for a specific screen type . You can optionally specify a timeout value. This transition command
must be inserted manually.

o SetCursor

Sets the cursor at a specific row and column on the screen. You can optionally choose to set the cursor in the current row,
column, or both.

e PutString

Writes a specific string to a specific row and column on the screen. You can optionally choose to write the string in the current
row, column, or both. This transition command must be inserted manually.

o Wait

Instructs the transition to wait for a specific number of seconds before executing the next transition command. In short, this
inserts a pause in the execution of transition commands.

Creating Transitions

Transitions contain the transition commands that Host Server uses to navigate between screens. There are two ways to create
transitions. The first way is to begin recording and create the transitions and transition commands automatically, naming screens
as you go. The second way is to first name all of the screens through which you will navigate and then create the transitions
manually. Both methods are discussed below.
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Creating Transitions and Transition Commands Automatically

While Interaction Host Recorder has many features, automatically recording transitions is one of the most powerful. The recording
feature allows you to record transitions, naming screens and creating transition commands as you go. Once you have recorded one
or more transitions, you can go back and edit the screen validation rules and transition commands.

e Step 1: Choosing a starting screen
If you are recording a normal transition from screen A to screen B, you must first decide which screen will be the starting point.
With a normal transition, you should start with a defined (named) screen. Once you have navigated to the starting screen, start
the recorder by clicking the Record button.

If you are recording the start up transition, you should start recording before connecting to the host.

o Step 2: Generating the Transition Commands
With the recorder running, navigate though the screens to the desired destination. Notice that the new transition commands are
listed in the transition command window. Each time you do something on the screen, a new transition command appears in the
list. (You can edit these when you finish recording.)

Transitions can cross multiple screens. The following diagram represents a collection of related screens. If you were recording
transitions, you could create a startup transition and transitions from A to B, Bto H, A to F, E to A, or any combination.

Startup E
Transition L
| 1 A B
‘H“"x
l:
C
e
D
H

e Step 3: Defining the Target Screen
When you have arrived at the destination screen and have finished working in that screen, press the Stop Recording button. If
the target screen is recognized, the Transition Target Screen dialog appears. If the target screen is not recognized, the Screen
Properties dialog appears where you can name the screen and define validation rules. Once you have selected (or created) a
name for the target screen, the transition appears as the currently selected transition list.
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o Step 4: Testing and Debugging the Transition
Now that you have created the transition, you should review the list of transition commands that were created automatically
and make any necessary changes. The transition commands for the selected transition appear in the Transition Commands
window. See transition commands for detailed information on each of the ten types of transition commands. See debugging
transtion for more information on cleaning up the auto-generated transition commands.

Creating Transitions Manually

While recording transitions automatically is almost always the best method, you can also create a transition manually. You do not
have to be connected to the host when creating transitions, but you must have the profile open in Interaction Host Recorder. To
create a transition command manually, right-click the transition list in the transition commands window and choose Add
Transition... from the menu that appears. Once you choose a Transition Target, you can manually insert and configure transition
commands.

When you have finished, debug the transition.

Debugging Transitions

Whether you recorded your transition automatically or created a one manually, testing and debugging the transition is important
before you publish a host profile to the Host Server.

Two buttons in the Interaction Host Recorder tool bar allow you to replay transitions, either all at once or one transition command
at a time.

e N

Replays all the transition commands listed in the Transition Commands window.

p- |Note: Remember that the transition commands are for navigating from screen A to screen B. You must have screen A loaded
before you replay the transition commands or they may fail. In fact, you should define validation rules and transitions so that
they will fail if started from the wrong screen. This way you can manage the errors from within handlers.

Replays a single transition command for the currently loaded host screen.

i
Note: Remember that the transition commands are for navigating from screen A to screen B. You must have screen A loaded
before you replay the transition command or it may fail.

If you see that one of the transition commands is causing problems, you can edit that transition command by right-clicking it and
choosing Edit... from the menu that appears. See Transition Commands for more information on specific transition commands.

Transition Commands window

The Transitions Commands window is where you create and edit transitions and the transition commands they contain. Transitions
are stored in the host profile, and when the Move to Screen tool requests a screen move, Host Server looks in the host profile for
the transition commands.

Transition Target Screen dialog

This dialog lists all the defined screens that match the current screen. When you finish recording a transition, this dialog appears
for you to select the target screen.

If there are no matching screens listed or if you don't want to use any of the matching screens, you can define a new screen by
clicking the New... button, which causes the Screen Properties dialog to appear.
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Trace History window

The Trace History window is a log of all commands sent from the Interaction Host Recorder to the Host and the Host's responses.
This includes all cursor movements, key presses, and screen changes. You can use the information in this window for debugging.
For example, if a transition playback fails for unknown reasons, check the Trace History window to determine which commands
failed to reach the host.

The information contained in this window accumulates as long as you are running Interaction Host Recorder. If you load a new host
profile, the new commands are appended to the trace history log. Click the Clear button to remove all entries from the Trace
History window.

The trace history related command line parameters are listed below:
\trace={type}

Sets level of tracing added to the trace buffer and shown in the trace history dialog.
{type}:

none - No tracing

error - Trace only errors

warning - Trace errors and warnings

status - Default, trace errors, warnings and status information

Notes: All of the above include additional verbose information about execution process.

The parameter keywords are not case sensitive.
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Screen Fields

Host Screen Fields window

All host screens are made up of protected and unprotected fields. When you open a screen in Interaction Host Recorder, all the
screen fields are listed in this window. You can use screen fields to define validation rules and user defined fields.

o Protected screen fields
These are read-only fields in which data is displayed. Handlers cannot change the value in a protected screen field. Examples of
a protected field include a screen label, a screen ID number, or account information in tabular form.

¢ Unprotected screen fields
These are read/write fields into which handlers can write data. An example of an unprotected field is a Choice where you type a
menu entry to change screens.

Creating validation rules from screen fields

Right-click on a screen field and choose Add as Validation Rule... to add the selected field as a validation rule. Interaction Host
Recorder creates a Match Text type validation rule. Right-click on the new validation rule if you want to make changes.

Creating user defined fields from screen fields

Right-click on a screen field and choose Add as User Defined Field to add the selected field. You can define the field as absolute or
ordinal.

Screen Fields (definition)

Screen fields are the fields that Interaction Host Recorder can read when a screen is opened. They are defined by the person who
programmed the screens, and Interaction Host Recorder lists them in the Host Screen Fields window.

Screen fields can be protected or unprotected:

o Protected screen fields
These are read-only fields in which data is displayed. If you create a user defined field from a protected field, a handler can only
read the data. You cannot change the value in a protected screen field. Think of protected fields as fields that can be read but
not changed.

o Unprotected screen fields
These are read/write fields into which data can be written. If you create a user defined field from an unprotected screen field, a
handler can write data to the screen. An example of an unprotected field is a Choice where you type a menu entry to change
screens.

See Host Screen Fields window for more information on screen fields.
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Configuration Options

Mnemonic keys (definition)

Keyboard mnemonics are ASCII characters that represent non-data keystrokes such as special function keys. For example, by
default the down-arrow key on your keyboard sends a @V command to the host screen. In a transition command, if only one
mnemonic key is sent to the host screen, Interaction Host Recorder will attempt to identify the label associated with that
mnemonic. For example, if you press the down arrow key once in a command, Interaction Host Recorder displays the text "Cursor
Down" in the transition command. If you press the down arrow key twice in one command, @V@V appears. This is due to a
limitation in Interaction Host Recorder's ability to parse complex mnemonic sequences.

The following list shows all the mnemonic keys mapped my default, You can change the mnemonic values and their labels on the

Keyboard Map page in the Preferences dialog.

Mnemonic Mappings

Meaning Mnemonic|Mainframe[AS/400
@ @@ X X
Alt @A X

Alt Cursor @e@1 X X
Attention @A@Q  |X X
Backspace @< X X
Backtab (Left Tab) |@B X X
Clear @C X X
Cmd (function) Key @A@Y X
Cursor Down @V X X
Cursor Left @L X X
Cursor Right @z X X
Cursor Select @e@1 X

Cursor Up @U X X
Delete @D X X
Dup @s@x X X
End @q X
Enter @E X X
Erase EOF @F X X
Erase EOL @e@d X
Erase Input @A@F X X
Field Exit @A@E X
Field Mark @S@y X

Field - @A@- X




Field + @A@+
Help @H
Hexadecimal @A@X
Home @0 (zero)
Insert @I
Insert Toggle @A@I
Local Help @e@!
Local Print @P
Local Help Cursor |@e@m
Left Tab (Back Tab)|@B
New Line @e@n
Page Up @u
Page Down @v
Print (PC) @A@t
Print Screen @A@T
Record Backspace |(@A@<
Reset @R
Right Tab (Tab) @T
Shift @S
Sys Request @A@H
Tab (Right Tab) @T
Test @A@C
PA1 @x
PA2 @y
PA3 @z
PA4 @+
PA5 @%
PA6 @&
PA7 @
PAS8 @(
PA9 @)
PA10 @*
PF1/F1 @1
PF2/F2 @2
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PF3/F3 @3 X
PF4/F4 @4 X
PF5/F5 @5 X
PF6/F6 @6 X
PF7/F7 @7 X
PF8/F8 @8 X
PF9/F9 @9 X
PF10/F10 @a X
PF11/F11 @b X
PF12/F12 @c X
PF13/F13 @d X
PF14/F14 @e X
PF15/F15 @f X
PF16/F16 @g X
PF17/F17 @h X
PF18/F18 @i X
PF19/F19 @ij X
PF20/F20 @k X
PF21/F21 @l X
PF22/F22 @m X
PF23/F23 @n X
PF24/F24 @o X

General Preferences
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Preferences (General page)

The Preferences dialog is where you can change how Interaction Host Recorder behaves. On the General page you can configure
several settings that will effect all of your editing sessions. These settings only affect how Interaction Host Recorder behaves while
you are editing, and they do not change any values within the host profiles.

Validation timeout

The amount of time Interaction Host Recorder will wait for a validation rule to be evaluated before returning a value of false.
Increase this value if you want Interaction Host Recorder to wait longer for screens to validate.

Transition commands timeout
The amount of time Interaction Host Recorder will wait for each transition command to execute before failing.
Track Current Screen option

Select this option if you want Interaction Host Recorder to validate and determine the name of the currently loaded screen each
time a change is made to that screen. If this option is not selected, Interaction Host Recorder will not check to see if the current
screen is a screen already defined in your host profile.

Show screen field parameter option
Select this option to view additional details about the screen fields.
Undo Stack Depth

Sets the number of undo levels available.

Other pages in the Preferences dialog:

e Preferences (Appearance page)

e Preferences (Host Fields page)

e Preferences (Keyboard Map page)
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Preferences (Host Fields page)

The Preferences dialog is where you can change how Interaction Host Recorder behaves. On the Host Fields page you can
configure the appearance of the unprotected and hidden screen fields. These settings only affect how Interaction Host Recorder
behaves while you are editing, and they do not change any values within the host profiles.

Unprotected Fields Text Color

The color of the text that appears in the unprotected fields. This setting allows you to override the color chosen by the screen's
designer. Change this setting to emphasize unprotected fields. Select automatic to disable this override.

Unprotected Fields Background Color

The background color of the unprotected fields. This setting allows you to override the color chosen by the screen's designer.
Change this setting to emphasize unprotected fields. Select automatic to disable this override.

Unprotected Fields fill characters
The character to display instead of blank spaces in an unprotected field.
Hidden Field options

Select Not Displayed to hide the contents of hidden fields. Select Fill with character to obfuscate any characters with a character
you select. Select Show Contents to not obfuscate the contents of hidden fields. This selection is important if you want to
obfuscate password entries.

Field Color Map

In this area you can re-map any colors programmed into the main screen.

Other pages in the Preferences dialog:

e Preferences (General page)

e Preferences (Appearance page)

e Preferences (Keyboard Map page)

Preferences (Appearance page)

The Preferences dialog is where you can change how Interaction Host Recorder behaves. On the Appearance page you can
configure several settings that will affect the colors and fonts of the host screen. These settings only affect how Interaction Host
Recorder behaves while you are editing, and they do not change any values within the host profiles.

Border color

The color of the border around the screen.

Background color

The color of the screen background.

Host field outline color

The color of the border around the Host Screen fields when those fields are selected in the Host Screen Fields window.
Screen outline color

The color of the thin outline between the screen and the border.
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Selection color

The color of the border around a manually selected portion of the screen.

Note: The color you specify is compared with a logical XOR with the color on the screen . This ensures that the selection is always
visible against the background. Do not specify black as the selection color.

Bound field outline color

The color of the border around user defined fields when those fields are selected in the User Defined Fields list.
Font name

The name of the font used when displaying text in a screen.

Preserve aspect ratio of font while in host screen view

Select this option to enlarge the screen to fit the aspect ratio of the font. This only affects viewing and will not impact coordinate
definitions in fields or transitions.

Show only true type fonts

Select this option to display only true type fonts in the font list.

Show only fixed pitch fonts

Select this option to display only fixed-pitch fonts in the font list. Fixed pitch fonts often dislay better than true type fonts.
Undo Stack Depth

The number of actions that Interaction Host Recorder will allow you to undo.

Other pages in the Preferences dialog:

e Preferences (General page)

e Preferences (Host Fields page)

e Preferences (Keyboard Map page)

49



Preferences (Keyboard Map page)

The Preferences dialog is where you can change how Interaction Host Recorder behaves. On the Keyboard Map page you can re-
map your keyboard to emulate a host terminal keyboard. Keep in mind that if you re-map function keys, such as F1, certain
Interaction Host Recorder functions may be available only from the menu. These settings only affect how Interaction Host Recorder
behaves while you are editing, and they do not change any values within the host profiles.

Key combination to map
This field contains the value of any keys you press on the keyboard. These are the keys that will be mapped.
Host Key

The key that will be written to the host screen when you press the key combination from the previous field.

Example: Mapping the text "exit" to Ctrl-X
1. On the Keyboard Map page, place your cursor in the Key combination to map field.
Press and hold the Ctrl key, then press the X key. "Control X" appears in this Key combination to map field.
Place your cursor in the Host Key field.
Type "exit".
Click the Assign button. Now, if the cursor is in an unprotected field and you press Ctrl-X, the word exit appears.

a s~ LN

Other pages in the Preferences dialog:

e Preferences (General page)

e Preferences (Appearance page)

e Preferences (Host Fields page)

Recording Settings
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Command Recording Settings (SendKey page)

Use the Command Recording Settings dialog to configure transition recording behavior. On the SendKey page you can configure
how your key presses are converted to transition commands.

Record Command option

Select this option if you want key presses recorded as transition commands. Clear this option if you do not want key presses
recorded as transition commands. If this option is selected, the following three options are available.

Record an individual command for each key option

If this option is selected, then each key press is recorded in its own transition command. Having individual transition commands for
each keystroke may offer more control, but it can lead to very large transitions.

Combine non-mnemonic keys into one command

If this option is selected, then all non-mnemonic keys are combined into one command until a mnemonic key is pressed. For
example, if you pressed A,B,C, Down-Arrow, E, and F, the ABC would all be in one command, down-arrow would be in one command,
and EF would be in one command.

Combine all keys into one command

If this option is selected, then all keys that you press are combined into one key command. For example, if you pressed A, B, down-
arrow, C, then the command would contain AB down-arrow C.
Other pages in the Preferences dialog:

e Command Recording Settings (SetCursor page)

e Command Recording Settings (WaitForCursor page)

e Command Recording Settings (WaitForRTS page)

Command Recording Settings (SetCursor page)

Use the Command Recording Settings dialog to configure transition recording behavior. On the SetCursor page you can configure
how your cursor movements are converted to transition commands.

Record Command option

Select this option if you want cursor movements recorded as transition commands. Clear this option if you do not want cursor
movements recorded as transition commands. If this option is selected, the following two options are available.

Discard immediate cursor movements

If this option is selected, then multiple cursor movements using the mouse are interpreted as one cursor movement to the final
location of the cursor. If this option is selected then each cursor movement becomes a separate command.

Convert keyboard cursor movements into 'SetCursor

If this option is selected, then cursor movements you make on the screen become SetCursor commands in the transition
command. This has the effect of moving the cursor to an absolute position instead of a relative position.

Other pages in the Preferences dialog:

e Command Recording Setting (SendKey page)

e Command Recording Settings (WaitForCursor page)

e Command Recording Settings (WaitForRTS page)

Command Recording Settings (WaitForCursor page)
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Use the Command Recording Settings dialog to configure transition recording behavior. On the WaitForCursor page you can
configure how Interaction Host Recorder adjusts wait for cursor commands. See the example at the end of this topic for a graphical
representation of the timeout calculation.

Record Command option

Select this option if you want wait for cursor commands automatically added to your transitions while you are recording.
Don't add command for cursor movements to (1,1)

If this option is selected, wait for cursor commands are added when the cursor moves to position (1,1).

Timeout Calculations

Configure these settings to add time to the timeout of a wait for cursor transition command. For example, while recording your
transition commands, a wait for cursor command takes one second. By configuring the timeout calculation settings, this time
could be automatically changed to 3 seconds.

Multiplier

The value by which you will multiply the wait for cursor time, multiplied by .1. For example, if you want to automatically double the
amount of time in the wait for cursor transition command, you would type twenty in this field: 20 x .1 = 2. If the wait for cursor time
while you are recording is 1 second, then the time value in the resulting transition command will be 2 seconds. If the wait for cursor
time while you are recording is 2 seconds, then the time value in the resulting transition command will be 4 seconds.

Caution: When setting the Multiplier value, take into account that slight variations in the host response time could cause the
Wait for Cursor to time out. Setting the multiplier value to 30 is generally sufficient, but thousands of handlers running
simultaneously may cause an unforeseen delay in host response. If your handlers are failing, check the handler logs to verify
that your multiplier values are sufficient.

Offset

The number of milliseconds to add to all wait for cursor commands. Type 1000 to add 1 second to all wait for cursor commands.

Minimum value

The minimum value to use in wait for cursor transition commands. If you typed 1000 in this field, all recorded wait for cursor
commands will last at least 1 second before timing out.

Example: In the following figure, if the recorded time is 2 seconds, the multiplier is 20, and the offset is 1000 ms, then the wait for
cursor transition command will have a time of five seconds.

Timeout
Walue 7
(Seconds)
5_
Cifset 31
Value 1 i
Inimum
Ty |*_va|ue Meastred
+ } } } } } } Tlme
1 3 5 7 (seconds)
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Other pages in the Preferences dialog:

e Command Recording Setting (SendKey page)

e Command Recording Settings (SetCursor page)

e Command Recording Settings (WaitForRTS page)

Command Recording Settings (WaitForRTS page)

Use the Command Recording Settings dialog to configure transition recording behavior. On the WaitForRTS page you can configure
how Interaction Host Recorder adjusts wait for RTS commands. See the example at the end of this topic for a graphical
representation of the timeout calculation.

Record Command option
Select this option if you want wait for RTS commands automatically added to your transitions while you are recording.
Timeout Calculations

Configure these settings to add time to the timeout of a wait for RTS transition command. For example, while recording your
transition commands, a wait for RTS command takes 2 second. By configuring the timeout calculation settings, this time could be
automatically changed to 5 seconds.

Multiplier

The value by which you will multiply the wait for RTS time, multiplied by .1. For example, if you want to automatically double the
amount of time in the wait for RTS transition command, you would type twenty in this field: 20 x .1 = 2. If the wait for RTS time while
you are recording is 1 second, then the time value in the resulting transition command will be 2 seconds. If the wait for RTS time
while you are recording is 2 seconds, then the time value in the resulting transition command will be 4 seconds.

Caution: When setting the Multiplier value, take into account that slight variations in the host response time could cause the
Wait for RTS to time out. Setting the multiplier value to 30 is generally sufficient, but thousands of handlers running
simultaneously may cause an unforeseen delay in host response. If your handlers are failing, check the handler logs to verify
that your multiplier values are sufficient.

Offset
The number of milliseconds to add to all wait for RTS commands. Type 1000 to add 1 second to all wait for cursor commands.
Minimum value

The minimum value to use in wait for cursor transition commands. If you typed 1000 in this field, all recorded wait for cursor
commands will last at least 1 second before timing out.

Example: In the following figure, if the recorded time is 2 seconds, the multiplier is 20, and the offset is 1000 ms, then the wait for
RTS transition command will have a time of five seconds.
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Other pages in the Preferences dialog:
e Command Recording Setting (SendKey page)

e Command Recording Settings (SetCursor page)

e Command Recording Settings (WaitForCursor page)




Publishing Host Profiles

Publishing Host Profiles

Publishing is the process by which the host profile is loaded onto the Host Server . Once a host profile is published, Host tools in
handlers can instruct the Host Server to perform actions based on the information in the profile.

Caution: When you publish a host profile, the data within that profile is loaded on to the Host Server. When opening a host
profile for editing, you have the choice of opening the host profile from the Host Server, or from the machine where you saved a
copy. If you choose to open and edit the profile loaded on the Host Server, keep in mind that it is possible that changes made
by others could cause the host profile on the server to be different than the host profile saved locally. In many cases, you may
want to open your local copy and republish any changes you make. This will ensure that both versions are identical.

To publish a host profile:
1. Open the Profile you want to publish.

2. From the File menu, choose Publish.
The file is published to the Host Server.

Manage Host Profiles dialog

The Manage Host Profiles dialog displays all the host profiles currently published on your Host Server. From this dialog you can
perform the following functions:

Add

Allows you to select and publish a host profile, this adding it to the list of published host profiles.

Delete

Removes the selected host profile from the server and the Published Profiles list.

Open

Opens the selected host profile in Interaction Host Recorder.

55



Glossary

Handler (definition)

A program built in the Interaction Designer program that performs some action or actions in response to the occurrence of some
event. A handler is a collection of steps (called tools) organized and linked to form a logical flow of actions and decisions.
Handlers are similar in structure to a detailed flowchart. Using Host tools in handlers allows a handler to send commands to the
Host Server.

Host (definition)

A computer to which one connects with a terminal emulator. A terminal emulator is a program that allows a computer to act as a
particular brand of terminal when accessing a host. Interaction Host Recorder has a built-in terminal emulator that you use to
create host profiles. Interaction Host Recorder can connect to two types of hosts: Mainframes and AS/400s.

Host Profile (definition)

Host profiles are the instructions that the Host Server uses to open and navigate through a host session. The Interaction Host
Recorder is the tool you use to create these instructions.

Host Server (definition)

The Host Server is the CIC server subsystem that executes the host profiles. Handlers can send commands to the Host Server; the
Host Server reads the host profile, navigates through screens, and reads and writes information.

Host Tools (definition)

Tools are like function calls within a handler. The Host tools enable handlers to send commands to the Host Server, which in turn
reads the host profile and performs the requested action on the host. For more information on Host tools and handlers, see the
Interaction Designer online help.

See Host Tool Overview for more information on how the host tools interact with the host profiles.

Mnemonic keys (definition)

Keyboard mnemonics are ASCII characters that represent non-data keystrokes such as special function keys. For example, by
default the down-arrow key on your keyboard sends a @V command to the host screen. In a transition command, if only one
mnemonic key is sent to the host screen, Interaction Host Recorder will attempt to identify the label associated with that
mnemonic. For example, if you press the down arrow key once in a command, Interaction Host Recorder displays the text "Cursor
Down" in the transition command. If you press the down arrow key twice in one command, @V@V appears. This is due to a
limitation in Interaction Host Recorder's ability to parse complex mnemonic sequences.

The following list shows all the mnemonic keys mapped my default, You can change the mnemonic values and their labels on the
Keyboard Map page in the Preferences dialog.

Mnemonic Mappings

Meaning Mnemonic|Mainframe|AS/400
@ @@ X X

Alt @A X

Alt Cursor @e@1 X X
Attention @A@Q X X
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Backspace @<
Backtab (Left Tab) |@B
Clear @C
Cmd (function) Key @A@Y
Cursor Down @V
Cursor Left @L
Cursor Right @Z
Cursor Select @e@1
Cursor Up @u
Delete @D
Dup @S@x
End @q
Enter @E
Erase EOF @F
Erase EOL @e@d
Erase Input @A@F
Field Exit @A@E
Field Mark @S@y
Field - @A@-
Field + @A@+
Help @H
Hexadecimal @A@X
Home @0 (zero)
Insert @!
Insert Toggle @A@I
Local Help @e@!
Local Print @P
Local Help Cursor |@e@m
Left Tab (Back Tab)|@B
New Line @e@n
Page Up @u
Page Down @v
Print (PC) @A@t
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Print Screen @A@T
Record Backspace |@A@<
Reset @R
Right Tab (Tab) @T
Shift @S
Sys Request @A@H
Tab (Right Tab) @T
Test @A@C
PAT @x
PA2 @y
PA3 @z
PA4 @+
PA5 @%
PA6 @&
PA7 @
PAS8 @(
PA9 @)
PA10 @*
PF1/F1 @1
PF2/F2 @2
PF3/F3 @3
PF4/F4 @4
PF5/F5 @5
PF6/F6 @6
PF7/F7 @7
PF8/F8 @8
PF9/F9 @9
PF10/F10 @a
PF11/F11 @b
PF12/F12 @c
PF13/F13 @d
PF14/F14 @e
PF15/F15 of
PF16/F16 @g
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PF17/F17 @h X X
PF18/F18 @i X X
PF19/F19 @i X X
PF20/F20 @k X X
PF21/F21 @l X X
PF22/F22 @m X X
PF23/F23 @n X X
PF24/F24 @o X X

Publishing (definition)

The process by which a host profile is made available on the Host Server . Once a host profile is published, handlers can use the
host profile to send commands to the host.

Screen (definition)

A host screen is the current contents of a connected terminal emulation window. You should assign names and validation rules to
all screens that you will use in transition.

Screen Fields (definition)

Screen fields are the fields that Interaction Host Recorder can read when a screen is opened. They are defined by the person who
programmed the screens, and Interaction Host Recorder lists them in the Host Screen Fields window.

Screen fields can be protected or unprotected:

o Protected screen fields
These are read-only fields in which data is displayed. If you create a user defined field from a protected field, a handler can only
read the data. You cannot change the value in a protected screen field. Think of protected fields as fields that can be read but
not changed.

e Unprotected screen fields
These are read/write fields into which data can be written. If you create a user defined field from an unprotected screen field, a
handler can write data to the screen. An example of an unprotected field is a Choice where you type a menu entry to change
screens.

See Host Screen Fields window for more information on screen fields.

Screen Type (definition)

Screen type is simply the number of unprotected fields in a screen. If a screen only has one unprotected field, then the screen type
will be 1.
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Screen ID (definition)

Each screen has a unique identifier generated mathematically from the number, position, and length of the fields. If you know that
the fields will always be in the same place and of the same length, you can rely on this value being the same each time the screen is
loaded. You can use screen ID even if some of the values within fields are going to change. For example, if there is a time stamp
located in the top left corner, and that field is always the same length, the screen will keep it's unique ID even if the time of day is
different.

Transition (definition)

Transitions are the mechanism by which Host Server navigates from screen to screen. You can create transitions in the Transition
Commands window. Transitions contain transition commands.

There are two types of transitions: normal and start up
e Normal transitions navigate from screen A to screen B. In the Transition list, normal transitions look like this:

ScreenA ——-——- > ScreenB

e Start up transitions are started just after the host connection is successfully established. It contains instructions for opening
the first screen. A profile may contain only one start up transition. In the transition list, the start up transition looks like this:

{connected} ——- > ScreenA

Note: When creating transitions, remember that they do not have to be to the next screen. A transition can navigate though several
screens before it arrives at the target screen. Be sure to add validation transition commands if you are building transition that cross
multiple screens.

See Transition Commands window for more information on transitions and transition commands.

Transition Commands (definition)

Transition commands are the instructions that make up a transition. You can record a series of transition commands automatically
by clicking the Start Recording button, or you can insert transition commands manually in the Transitions Commands window.

See Transition Commands window for more information on creating transition commands.

User Defined Fields (definition)

User defined fields are fields you create to allow handlers to write information to and from screens. User defined fields enable
handlers to navigate and process information within screens just like a person would. You must create user defined fields, as
opposed to screen fields that Interaction Host Recorder creates automatically when a screen is opened.

See Screen Definition window for more information on creating user defined fields.

Validation Rules (definition)

Validation rules contain criteria for identifying the currently loaded screen. When a screen appears, Interaction Host Recorder
checks the validation rules to determine which screen is loaded. Validation rules can include screen ID, the position of text on the
screen, and several other defining characteristics of a screen.

See Validation Rules for more information on the types of validation rules and how you can configure them.
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Miscellaneous topics

File Open dialog box

The following options allow you to specify which file to open:

File Name

Type or select the filename you want to open. This box lists files with the extension you select in the List Files of Type box.

List Files of Type

Select the type of file you want to open:

LCS is the only type that can be opened with Interaction Host Recorder.

Drives

Select the drive in which Interaction Host Recorder stores the file that you want to open.

Directories

Select the directory in which Interaction Host Recorder stores the file that you want to open.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.

File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name

Type a new filename to save a host profile with a different name. A filename can contain up to eight characters and an extension of
up to three characters. Interaction Host Recorder adds the extension you specify in the Save File As Type box.

Drives

Select the drive in which you want to store the host profile.

Directories

Select the directory in which you want to store the host profile.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.
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Status Bar

cAP |

The status bar is displayed at the bottom of the Interaction Host Recorder window. To display or hide the status bar, use the Status
Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. This area
similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them. If after viewing
the description of the toolbar button command you wish not to execute the command, then release the mouse button while the
pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched
down.
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Toolbar

Di=E

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick mouse access
to many tools used in Interaction Host Recorder.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below. >>

To

Open a new host profile.

o
O |f
.x

Open an existing host profile. Interaction Host Recorder displays the Open dialog box, in which you can locate
and open the desired file.

[

Save the active host profile or template with its current name. If you have not named the host profile,
Interaction Host Recorder displays the Save As dialog box.

D

Remove selected data from the host profile and stores it on the clipboard.

[

Copy the selection to the clipboard.

i

Insert the contents of the clipboard at the insertion point.

@

Reverse the last editing. Note: You cannot undo some actions.

5

Accessing Connection Properties

Open the Connection Properties dialog by choosing Connection Properties... from the Host menu.

You can only access the Connection Properties dialog after opening or creating a new host profile.

About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Interaction Host Recorder.
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Exit command (File menu)

Use this command to end your Interaction Host Recorder session. You can also use the Close command on the application Control
menu. Interaction Host Recorder prompts you to save host profiles with unsaved changes.

Shortcuts

Mouse: Double-click the application's Control menu button.

Keys: A F4
Context Help command

Use the Context Help command to obtain help on some portion of Interaction Host Recorder. When you choose the Toolbar's
Context Help button, the mouse pointer changes to an arrow and question mark. Then click somewhere in the Interaction Host
Recorder window, such as another Toolbar button. The Help topic is shown for the item you clicked.

Shortcut
Keys: SHIFT+F1

Default Connection Drivers

Several default connection drivers are installed with Interaction Host Recorder. We recommend that you use the default drivers
unless instructed to change them by a PureConnect Customer Care agent. Refer to the following table for the default driver for Host
Type/Server pair.

Host Type/Interface Pair Recorder Driver Server Driver

Mainframe TN3270 I3WdExpMFDriver I3WdExpMFDriver|
Mainframe MS SNA Server I3WdExpMFDriver I3WdExpMFDriver

AS/400 TN5250 IBWdExpASDriver I3WdExpASDriver

AS/400 MS SNA Server  I3WdExpASDriver I3WdExpASDriver

"
_I How to access the Connection Properties dialog

Copy command (Edit menu)

Use this command to copy selected data onto the Clipboard. This command is unavailable if there is no data selected.
Copying data to the Clipboard replaces the contents previously stored there.
Shortcuts

Toolbar:

Keys: CTRL+C




Cut command (Edit menu)

Use this command to remove the currently selected data from the host profile and put it on the Clipboard. This command is
unavailable if there is no data selected.

Cutting data to the Clipboard replaces the contents previously stored there.

Toolbar:

Keys: CTRL+X

Shortcuts

Paste command (Edit menu)

Use this command to insert a copy of the Clipboard contents at the insertion point. This command is unavailable if the clipboard is
empty.

Shortcuts

Toolbar:

Keys: CTRL+V

Redo command (Edit menu)

Use this command to reverse the last undo action, if possible. The name of the command changes, depending on what the last
action was. The Redo command changes to Can't Redo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar: ﬂ

Keys: CTRL+Z or
ALT-BACKSPACE

Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible. The name of the command changes, depending on what the last
action was. The Undo command changes to Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar: ﬂ

Keys: CTRL+Z or
ALT-BACKSPACE
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Close command (File menu)

Use this command to close all windows containing the active host profile. Interaction Host Recorder suggests that you save
changes to your host profile before you close it. If you close a host profile without saving, you lose all changes made since the last
time you saved it. Before closing an untitled host profile, Interaction Host Recorder displays the Save As dialog box and suggests
that you name and save the host profile.

You can also close a host profile by using the Close icon on the host profile's window, as shown below:

1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four host profiles you closed. Choose the
number that corresponds with the host profile you want to open.

New command (File menu)

Use this command to create a new host profile in Interaction Host Recorder.

You can open an existing host profile with the Open command.

Shortcuts

Toolbar:

Keys: CTRL+N

Open command (File menu)

Use this command to open an existing host profile in a new window. You can open multiple host profiles at once. Use the Window
menu to switch among the multiple open host profiles. See Window 1, 2, ... command.

You can create new host profil with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O

hid_file_publish

Publish command (File menu)

Use this command to publish the loaded profile to the Host Server. See Publishing Host Profiles for more information on using
this command.

Save As command (File menu)

Use this command to save and name the active host profile. Interaction Host Recorder displays the Save As dialog box so you
can name your host profile.

To save a host profile with its existing name and directory, use the Save command.
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Save command (File menu)

Use this command to save the active host profile to its current name and directory. When you save a host profile for the first time,
Interaction Host Recorder displays the Save As dialog box so you can name your host profile. If you want to change the name and
directory of an existing host profile before you save it, choose the Save As command.

Shortcuts

Toolbar:

Keys: CTRL+S

Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step instructions for
using Interaction Host Recorder and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.

Using Help command (Help menu)

Use this command for instructions about using Help.

Connect Command (Host Menu)

Use this command to connect using the connection properties for the currently loaded profile.

Shortcuts

%a)

Toolbar:

Connection Properties (Host Menu)

Opens the Connection Properties dialog box.

Dis connect Command (Host Menu)

Use this command to disconnect the current host session.
Shortcuts

LY

Toolbar:

Host Tool Overview

Host tools are the tools in handlers that can tell Host Server to run parts of a host profile. Host tools use the values in your host
profile to connect to the host, navigate to a screen, send or receive data, and perform other operations. The following list contains
a summary of the Host tools you can use in your handlers. See the Interaction Designer online help for more information on using
these tools.

Host Connect

Loads a profile and connects to a host using the connection properties in that profile. The open connection is placed in a
connection variable so that other Host tools can perform actions stored in the profile.
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Host Disconnect

Disconnects from the host.

Host Fetch Form Data

Binds user defined fields to variables in the handler and then retrieves values from that host screen.

Host Find String

Returns the row and column coordinates of a string you specify.

Host Get Cursor Position

Returns the row and column coordinates of the current cursor position.

Host Get Screen

Returns the contents of a screen in a list of string variable where each row on the screen is an element in the list. You can then
process this list of string variable in a handler.

Host Get String

Retrieves any number of characters starting at a row and column coordinate that you specify.

Host Move to Position

Moves the cursor to a row and column coordinate that you specify.

Host Move to Screen

Executes a transition from one screen to another.

Host Press Key

Sends one or more key presses to the currently loaded screen.

Host Put Form Data

Writes data from variables in the handler into the user defined fields in a screen.

Host Put String

Writes a string to a row and column coordinate that you specify.

Host Verify Screen

Runs all validation rules for the current screen. If the validation rules fail, this tool fails.
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Host Wait for Cursor

Instructs the handler to wait for the cursor to appear at a certain location. You can specify a timeout for this operation.

Host Wait for ReadyToSend

Instructs the handler to wait for a ready to send signal from the screen. You can specify a timeout for this operation.

Host Wait for Screen

Waits for all validation rules for a screen to evaluate true.

Host Wait for String

Waits for a specified string to appear at specified row and column coordinates on the terminal emulation.

Title Bar

Interaction Host Recorder

The title bar is located along the top of a window. It contains the name of the application and host profile.
To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title bars.

A title bar can contain the following elements:
Application Control-menu button

Host profile Control-menu button
Maximize button

Minimize button

Name of the application

Name of the host profile

Restore button

Add User Defined Field

Opens the User Defined Field dialog box where you can create a user defined field.

Shortcuts

@

Toolbar:

Add Screen Command

Opens the screen properties dialog box where you can define the properties of the currently loaded screen.
Shortcuts

&

Toolbar:

69



Naming Screens

Screen names are the labels used to represent a unique screen. After you name a screen, you can create validation rules and user
defined fields.

When you open a screen, Interaction Host Recorder tries to identify the currently loaded screen and indicates the level of
recognition with one of the following icons:
e ™

All validation rules are true for the currently loaded screen.

At least one validation rule is true for the currently loaded screen.

% All validation rules are false for the currently loaded screen.

. J/
The Screen drop-down list shows all of the screens currently defined in the profile. When you load a screen or make a change to a
screen, Interaction Host Recorder tries to match the screen with a defined screen name. The following figure illustrates how
Interaction Host Recorder attempts to track all defined screens against the currently loaded screen. In this example, LoginScreen is
an exact match, while AuthorGuide is a partial match.

Screen: |% LoginScreen j

% LoginScreen
o AuthorGuide
M Authorl ndes

¥ Connecting

¥ MainMenuPgl
¥ MainMenuPg2

For screen debugging purposes, Interaction Host Recorder also displays which validation rules and user defined fields are true,
partially true, or false.

Turning Screen Tracking On and Off
Depending upon the types of validation rules defined for a screen, something as small as moving a cursor can prevent Interaction

Host Recorder from finding a screen match. While sometimes useful, you may encounter problems, especially when trying to create
user defined fields. You can turn off automatic screen tracking from the Tools menu my choosing Preferences... Track Current

Screen.

When screen tracking is on, Interaction Host Recorder tries to display the screen definition of the currently active screen. When
screen tracking is off, changes to the screen do not automatically load a new screen definition, allowing you to define validation
rules and user defined fields on the unmatched or partially unmatched screen.

Recording Settings (Tools Menu)

Opens the Connection Properties dialog box.

Preferences (Tools Menu)

Opens the Connection Properties dialog box.
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Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single host profile, the Close command on the host profile Control menu closes only
one window at a time. You can close all windows at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a host profile window

ALT+F4 closes the host profile window or dialog box

Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon on the title bar; or double-click the title bar.

Keys: CTRL+F10 enlarges a host profile window.

Minimize command (application Control menu)

Use this command to reduce the Interaction Host Recorder window to an icon.

Shortcut

Mouse: Click the minimize icon on the title bar.
Keys: ALT+F9

Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow keys.

&

Note: This command is unavailable if you maximize the window.
Shortcut
Keys: CTRL+F7
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Next Window command (host profile Control menu)

Use this command to switch to the next open host profile window. Interaction Host Recorder determines which window is next
according to the order in which you opened the windows.
Shortcut

Keys: CTRL+F6

Previous Window command (host profile Control menu)

Use this command to switch to the previous open host profile window. Interaction Host Recorder determines which window is
previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6

Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize command.

Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

&

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcut

Mouse: Drag the size bars at the corners or edges of the window.
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Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an application on the list.
Shortcut
Keys: CTRL+ESC

Dialog Box Options

When you choose the Switch To command, you will be presented with a dialog box with the following options:

Task List

Select the application you want to switch to or close.

Switch To

Makes the selected application active.

End Task

Closes the selected application.

Cancel

Closes the Task List box.

Cascade

Arranges open applications so they overlap and you can see each title bar. This option does not affect applications reduced to
icons.

Tile

Arranges open applications into windows that do not overlap. This option does not affect applications reduced to icons.

Arrange Icons

Arranges the icons of all minimized applications across the bottom of the screen.

Manage Profiles (Tools Menu)

Opens the Connection Properties dialog box.
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LA

~ Play Single Step Button

Plays back a single transition command in the currently selected transition. The status of each transition command is indicated
with an icon. See debugging transitions for more information.

Note: Remember that the transition commands are for navigating from screen A to screen B. You must have screen A loaded before
you replay the transition commands or they may fail.

See Creating Transitions for more information.

>

= Play Button

Plays back all transition commands in the currently selected transition. Each status of each transition command is indicated with
an icon. See debugging transitions for more information.

Note: Remember that the transition commands are for navigating from screen A to screen B. You must have screen A active before
you replay the transition commands or they may fail.

See Creating Transitions for more information.

)

Starts recording transition commands. All actions you perform in the host screen are recorded as transition commands in the
Transition Commands window.

Record Button

See Creating Transitions for more information.

=

Stops the recording session. After pressing this button your actions are no longer recorded as transition commands. You must
stop the automatic transition recording before you can begin debugging transitions.

Stop Button

See Creating Transitions for more information.

Trace History (Tools Menu)

Opens the Connection Properties dialog box.

Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu item or
depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.

Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in Interaction
Host Recorder, such as File Open. A check mark appears next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.
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1, 2, ... command (Window menu)

Interaction Host Recorder displays a list of currently open host profile windows at the bottom of the Window menu. A check mark
appears in front of the host profile name of the active window. Choose a host profile from this list to make its window active.

Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an open host profile
window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this
host profile window.

Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.

New command (Window menu)

Use this command to open a new window with the same contents as the active window. You can open multiple host profile
windows to display different parts or views of a host profile at the same time. If you change the contents in one window, all other
windows containing the same host profile reflect those changes. When you open a new window, it becomes the active window and
is displayed on top of all other open windows.

Split Command (Window menu)

Use this command to split the active window into panes. You may then use the mouse or the keyboard arrows to move the splitter
bars. When you are finished, press the mouse button or enter to leave the splitter bars in their new location. Pressing escape keeps
the splitter bars in their original location. << In a single host profile interface application, this command will appear on the View
menu. >>

Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.

Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.

Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.
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Connection Attributes for Mainframe MS SNA Server

The following fields are available on the Attributes page if Mainframe MS SNA Server is the Host Type/Interface pair chosen on the
Connection Properties General Page.

5l
How to access the Connection Properties dialog

LU

Returns the name of the logical unit (LU) or LU Pool on the server. The LU determines which host the control connects to. An LU is
a type of Network Addressable Unit that enables end users to communicate with each other and gain access to SNA network
resources.

Dockable Windows

Three dockable windows can be displayed in the Interaction Host Recorder. You can configure whether the window is docked by
right-clicking inside the window and choosing Allow Docking from the menu that appears. In the View menu a check mark appears
beside each window that is currently displayed.

e Screen Definition window

Displays screen names, validation rules, and user defined fields.
e Host Screen Fields

Displays the protected and unprotected screen fields contained in the currently loaded screen.
¢ Transition Commands

Allows you to view and configure transitions and transition commands.

Screen Definition window

Host screens are the screens displayed in a terminal emulation. After connecting to a host for the first time or opening a screen for
the first time, you must name each screen and determine what characteristics define that screen. These defining characteristics are
called validation rules, and they are used to determine which screen is currently loaded. Once you have named a screen and
configured your validation rules, you can create user defined fields that allow handlers to read and write data in that screen.

This topic contains links to more detailed explanations:

e Naming and identifying screens
Named screens are screens that Interaction Host Recorder can identify with validation rules. Before you can create validation
rules or define fields on a screen, you must name that screen. The host tools in handlers refer to screen names when sending
instructions to the Host Server. See Naming Screens for more information.

e Viewing or creating validation rules
Validation rules contain information for identifying the currently loaded screen. When a screen appears, Interaction Host
Recorder checks the validation rules to determine which screen is loaded. See Validation Rules for information on the different
types of validation rules.

e Creating user defined fields that are recognized by the host tools in handlers
When you create a user defined field in the Screen Definition window, handlers can read information from the field or write
information to the field. See Screen Fields for more information on the different types of screen fields.

Interaction Host Recorder Help Index

Commands
File menu
Edit menu
View menu
Window menu

Help menu
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Edit menu commands

The Edit menu offers the following commands:

Undo [Reverse previous editing operation.

Cut |Deletes data from the host profile and moves it to the clipboard.

Copy |Copies data from the host profile to the clipboard.

Paste|Pastes data from the clipboard into the host profile.

File menu commands

File menu commands

The File menu offers the following commands:

Ne Creates a new host profile.

Open Opens an existing host profile.

Close Closes an opened host profile.

Save Saves an opened host profile using the same file name.

Save As | Saves an opened host profile to a specified file name.

xit Exits Interaction Host Recorder.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Help Topics | Offers you an index to topics on which you can get help.

About Displays the version number of this application.

View menu commands

The View menu offers the following commands:

Toolbar [Shows or hides the toolbar.

Status Bar|Shows or hides the status bar.
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Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple host profiles in the
application window:

New Window |Creates a new window that views the same host profile.

Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange Icons |Arranges icons of closed windows.

Split Split the active window into panes.

Window 1, 2, ...|Goes to specified window.

Scroll bars

Displayed at the right and bottom edges of the host profile window. The scroll boxes inside the scroll bars indicate your vertical and
horizontal location in the host profile. You can use the mouse to scroll to other parts of the host profile.
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Change log

Date

Changes

28-February-2019

Created this change log.
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